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Challenge Creation:                                      ♘ 
(lastmodified=28/11/23) 

(lastmodified=30/11/23) 

 

 

 

About this form: 
This is the instructions form for challenge creation. In it you will be 
instructed on organizing challenges, making new challenges and using 

the other forms relating to challenge creation.  

 

Instructions: 

Before you attempt to take on creating a challenge for the Living Way you have to understand what a 

challenge is and what the purpose of the challenge is. A challenge is supposed to be a question, puzzle or 

game that requires the recipient of the challenge to think and then solve that challenge. Because the 

challenges we are creating are for the Living Way Youth Magazine, the challenges should be related to the 

AOY, AOY doctrine or the Bible in some way. By using your talents to create challenges for the Assemblies of 

Yahweh, you will benefit spiritually from it and so will the recipients of that challenge.  

Therefore, these challenges that are to be sent in to the Living Way are storing up a wealth of material, 

perhaps for the Living Way Magazine if it does start up again or 

perhaps for something else, like simply a challenge booklet that 

can be sold at the F.O.T auction or used in Dalet School.  

Challenges are really special because it requires thought and 

propels us to become better students of the Bible, no matter 

where we are or what age we are. However, you should bear in 

mind that this category was created in particular, so we the 

older could create something to help the younger in the 

ministry. Magnifying the Word for the youth is not easy, but 

Bible challenges really hits the spot when it comes to youth.  
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Challenge descriptions

The editor has created a basic method of organizing challenges to be sent to the Living Way by creating 

something called Challenge Letter Codes. A challenge letter code is a code which allows us to specify what 

type of challenge it is. A full code should comprise of two letters. The challenge letter code appears in what we 

call the challenge description. All challenges should have accompanied with it a challenge description. A 

challenge description is simply the text preceding the challenge. All the challenges we create for the Living 

Way should in their challenge descriptions consist of the following things: 

• A challenge letter code 

• The challenge name  

• The difficulty of the challenge (if it is not medium) 

• The points the challenge is worth  

• The challenge instructions (goes on the second or third line) 
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Because the above challenge is considered by the challenge creator to be a ‘medium’ one in 

terms of difficulty, there is no difficulty setting mentioned in the challenge description. If a 

challenge is considered to be medium in its difficulty setting, you should not write any 

difficulty setting on the challenge. If you, as a challenge creator, think a challenge should be 

labeled as easy, hard or difficult then add this to the challenge description after the points system is mentioned, 

in other words, on the first line of the challenge description, right at the end. Do so in brackets as shown below: 

 

 

Again, all of the text preceding the challenge is called the challenge description because it gives information 

about the challenge.  We have copied just the challenge description from the above example and pasted it 

below:  

 

 

 

When you create your challenge, you’ll need to write out the challenge description. You’ll need to stick to the 

format that we have used, from the font style even down to the font size. This is so we can standardize the 

challenges we send over to the Living Way and make it easier for the AOY to use in the Living Way Magazine. 

The text in the challenge description is always font Arial and font size 11. The first line in the challenge 

description is always in bold. The challenge letter code is always highlighted yellow using the Text Highlight 

Colour tool which in Microsoft Word 2007 is in the Home tab above the Font dialog box.  

Symbols in the challenge 

So far, C. challenges are the only challenges which require a symbol next to the challenge 

name. That symbol is this paint brush symbol (). In Microsoft Word 2007, if you go to the 

Insert tab > Symbol > More Symbols  and then Font Wingdings 2 it’s character code is #35. 

The editor had devised symbols for all of the different challenge categories, but decided to 

simplify it down by just using a symbol for the challenges that require the most raw 

talent, which is C. challenges.  

If you think you have some drawing ability, we highly recommend you give C. challenges a go.  

About challenge letter codes

A full challenge letter code consists of two letters, separated by a dot. The first letter in the challenge letter 

code tells us the category to which the challenge belongs. Those categories are listed below: 

A. Once-a-week N. AOY literature challenges and 

quizzes 

B. Q & A O. Seasonal 

L.D Bad Word challenge (2 points) (Easy) 
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C. Creative P. Internal rotating challenges 

(Please ignore this for now) 

D. Match  Q. Listen and watch challenges 

E. Crosswords and Puzzles R.  

F. Locate S. Sweet 

G. Target T. Building Character 

H. Live chat challenges and 

groups 

U.  

I. Missing Word  V.  

J. Bible Studies W. Names, titles and places 

K. Scripture That X. Miracle Riddle Parable  

L. Word  Y. Number 

M. Creative writing Z. Law 

 

An example then is that Z. Challenges are all Law challenges which concentrate on the Law of Yahweh. The 

second letter in the 2-letter challenge letter code simply specifies exactly what the challenge is, as you can see 

on the ‘Challenges to Create’ PDF. So challenge Z.A is a 

Law Quiz, which differs from challenge Z.B, which is a Law 

Challenge.  

In other words, from a 2-letter challenge letter code the Living 

Way will be able to tell what the challenge is and won’t even 

need the challenge name. This way, challenges will be easily 

able to referred to, monitored and processed which will be 

important when the Living Way starts receiving a number of 

challenges.  
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So you want to create a challenge. You’ve read the above and you might be thinking, where do you get a 

challenge code from? Where do you start when coming up with a challenge? On 

www.messianicisraelite.com on the Challenge Creation page are several different files. 

One of those files should be a PDF called ‘Challenges to create’. There you have listed 

the challenges the editor could think of for the Living Way magazine. Each challenge 

has a challenge letter code, so you just have to choose a challenge from that 

page to create, and copy the accompanying challenge letter code, 

challenge name and if it has one, point system, from that PDF. 

There’s a section on this instructions form about what to do if you want 

to create a challenge that is not on our list. It is under the heading Creating 

challenges not on our list and it is contained on the latter pages of this 

document.   

The difference between challenges and 

quizzes 

You will find on the Challenges to create form, they are some names which include the word challenge and 

others which include the name quiz. The difference is, usually quizzes are text-based challenges, which 

comprise of about 3 different questions or sub-challenges.  

Just because they are text-based challenges, it doesn’t mean you have to be bland when it comes to creating 

the challenge. You can use tables, text boxes, colour, the Snipping Tool and then picture effects if you like. Be 

creative.  

The points system

They are 3 different point systems you can use for your challenges, PP, PO and PA. 

Generally speaking, the amount of points a challenge is worth is always in brackets on the 

first line of the challenge description.  

1. Points Per Answer (PP) 

The most frequently used point system is where you get 1 point for each correct answer. This is the PP point 

system. However, if a challenge is worth 1 point only, you must only use the PO point system. Below is a 

demonstration of this PP point system: 

http://www.messianicisraelite.com/
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As you can see, they are three answers which are worth 1 point each. Therefore, the challenge is worth 3 

points in total. Just enter the amount of points the challenge is worth with a number, and follow it by the word 

points.  

2. Points Only (PO)  

The second point system is abbreviated as PO. It uses the word ‘only’ i.e. ‘3 points only’ or ‘1 point only’. It 

means the challenge is worth either 0 points (for the wrong answer), or the amount of points the challenge 

states (for the right answer). This point system is most useful if for example the challenge is a difficult one and 

undeserving of just 1 point. An example of this is shown below: 

 

Points Only 

A rather rare but additional thing you may do with the PO point system is that if you have a challenge which is 

worth X amount of points (so long as it is not 1 point only), but you want to give the recipient of that challenge a 

clue, or the ability to look at their notes, or the Bible, you may edit the point system to abbreviate ‘points only’ 
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as ‘PO’ and add the +/- symbols as seen here: (+/- 1PO / 2PO ). This would mean a challenge can be 

worth either 1 point only, or 2 points only, depending on if the recipient of the challenge used an aid to help 

them complete the challenge. In the answers section it would be (+/- 1PO / 2PO ) . The overall 

points for tallying them up at the end would still be out of 2 points in this case. You could change the points, for 

example (+/- 1PO / 3PO). In the challenge instructions, and challenge answer instructions you would have 

to write out the details of the point system.  

3. Points available (PA)  

The third point system is abbreviated and referred to as the PA point system and it uses the word ‘available’ or 

‘altogether’ i.e. ‘(3 points available)’ or ‘(4 points altogether)’. It means that there are a total of that many points 

available; however, different parts of the challenge may be worth more or less than others depending on how 

difficult it is. Normally, in the case of the ‘available’ point system, you should break down how much points 

each part of the challenge is worth. Below is an example: 

 

You’ll recognise that you can use ‘available’ or ‘altogether’ in the PA point system. It doesn’t matter which.  

Different answers for point systems in the 

answer challenge 

instructions

If you want to give the recipient of the challenge options to 
which they could get points for their answer, you may type 
OR after the challenge answer, and under it write the 
alternative answer or if they are other answers writing OR 
after each subsequent answer and the answer below. If they 
are multiple answers required for a challenge you might write 
AND after the answer is mentioned and write the additional 
answer or answers below, writing AND as necessary. Both of 
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these elements, either OR & AND need to be written in capital letters. Further, it has been our practice to use a 
‘=’ sign before our answer, which is useful to make it absolutely clear what the answer is.  

Scale of points for the PO point system

 

 
You shouldn’t award a challenge more than ‘3 points only’ if using the PO point system. If you use the PO point 
system, you should base your points settings on how difficult the challenge is. Above are the points that should 
be awarded based on how difficult a challenge is. However, if your point system reflects the difficulty of the 
challenge, you don’t need to include a difficulty setting in the challenge description. Only if your challenge point 
system does not reflect the difficulty of the challenge must you put the difficulty setting in the challenge 
description. If for example a difficult challenge has only been given a ‘1 point only’ point setting you should put 
in the challenge description “(Difficult)” because it’s difficult to get that 1 point.  
 

If using the PP or PA point system, you will have to use your own judgment. Note that with PP and PA you can 
have several more points than just 3 points so it’s impossible to determine a point scale, however, when 
coming up with the points for the PA point system, remember that you shouldn’t give a single answer segment 
any more than 3 points. 
 
This is to ensure everyone uses a similar framework for calculating how much points a challenge is worth.  

 

Difficulty settings and ‘Kids’

Although there is some discrepancy between old challenges we created and new ones, the 

difficulty setting of the challenge should go on the first line of the challenge description right at the 

end in brackets and the first letter in the brackets should be capitalized such as “(Easy)” or 

“(Hard)”. They are four difficulty settings: easy, medium, hard or difficult, difficult being the 

hardest difficulty setting. Medium difficulty settings should not be included in the 

challenge description. There should be a space between the different bracketed 

texts.  

 
If your challenge is specifically for children, then write “(Kids)” in brackets on the first line of the 
challenge description, after the challenge difficulty is mentioned. This will mean usually you’ll 
have a challenge description that reads “(Easy) (Kids)” at the end because challenges aimed at 
children should be quite easy. However, it is possible that a challenge aimed for kids is difficult 
for kids to do, if so, write the relevant difficulty setting in brackets. So write (Kids) after the 
difficult setting. Indeed, saying “(Kids)” is also seen as a type of difficulty setting which is why 
we’re including it here in this section.  

 
 

 
 
Kids + 
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If a challenge has been designed for kids and adults, you can put ‘Kids +’. Often if this is the case, you can 
specify in the challenge description what adults should do to differentiate it from the kids – often this will make 
the challenge more difficult. For example, see below. Note that if you have a Kids + challenge, the difficulty 
setting you use should be for the adults, not the kids. So for example, if the adults aspect is difficult put 
“(Difficult) (Kids +)”.  
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What we’

We’ve covered where to go to get your challenge ideas and your challenge 

letter code. To recap, you go to the ‘Challenges to create’ PDF. If you want 

to create a new challenge that isn’t on the list, then there is a section right at 

the bottom of this document called ‘Creating challenges not on our list’ 

which you should read through. Because we are using the internet as a 

unifying factor for the AOY, the challenges we have devised have been done 

using a program that most Windows computers have, Microsoft Word. 

However, this is also very limiting to what we can do. To create challenges in 

the past using Word, we’ve used mainly tables, smartArt and the Snipping Tool. 

The primary target age we have concentrated on is 16 – 25 year olds and most people at this age are usually 

quite adept at using a computer so using Word to create challenges shouldn’t be too difficult. However, we 

want to emphasise that you do not need to and actually shouldn’t just use exclusively Microsoft Word to create 

challenges.  

Feel free to hand-draw challenges if you have the talent. Hand-drawn challenges 

will be much appreciated and add flavour to the challenges we create. 

Nonetheless, your challenge description should always be typed in 

Microsoft Word. That means you’ll have to use a scanner to scan your 

hand-drawn challenge, then insert it in to Microsoft Word in the Create a 

challenge document, then type up your challenge description.  

Remember, it’s important that you try to make your challenge as aesthetically 

pleasing as possible, so use colour. Also, since the text should be as 

clear as possible, it is advisable to use the computer to write all text in the 

challenge. They are also some great designer applications out there such as the 

Procreate app for the iPad and Affinity Designer. As we get more people brought in to the 

Assemblies of Yahweh, it is expected that more of a knowledge of these programs will be able to be 
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brought in to the faith and be utilized for Yahweh’s honour and glory especially by the youth who seem to be 

more familiar with these programs.  

  Use of tables,  the snipping tool and 

smartArt 

Tables   

Tables are very helpful for creating certain challenges, such as E.B wordsearches and their clues or E.C 
crosswords and their clues or D. Match challenges. They are also useful for creating the challenge answers 
to those challenges which have multiple answers to choose from.  
 
When you’re creating the grids for the wordsearches and crosswords, you can do this easily by inserting the 

table and then clicking on the Layout tab and in the Cell Size section change the Height and Width to the same 

size such as seen below: 

 

This will ensure your cell sizes are all equal. You can once you have created your grid, change the border 

thickness, border colour, cell colours, text size etc until you are pleased with the product.  

Snipping Tool  

In Windows 2007 there is a tool called the Snipping Tool. It’s a brilliant tool. You can use it to capture anything 

on your computer screen and it turns it in to a picture, like the print screen key, but better. As a picture then 

you will not be able to change the content of that picture, so you have to be certain that your challenge is 

accurate, however, you can then, once it’s a picture, add some effects to it in Microsoft Word, and other 

programs, such as Photoshop or Fireworks.  

To get the Snipping Tool go to the Start menu > All Programs > Accessories > Snipping Tool. Once, you have 

it you go to whatever you want to convert to a picture, then open the tool, go to ‘New’ and click on the 

downwards arrow. Normally, you’d select Rectangular Snip. 

 

Then use it to ‘Snippet’ your challenge. Once done, in the Snipping Tool go to Edit > Copy and then paste it in 

to Microsoft Word again. Then, once you’ve double-clicked on the picture, you’ll be able to add some  effects 

as seen below under the Format tab: 
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That’s the essence of using the Snipping Tool. If you cannot use the Snipping Tool, use the Print screen key 

on your keyboard, then crop the image. You should magnify your document by going to the View tab > Zoom 

and magnify the document so the object is clearly visible before you Print screen.  

A few Tips  

Go to Tools > Options and ensure that the ‘Show selection ink after snips are captured’ option is not on. We do 

not want such borders around the challenge. See the below printscreen. . 

 

• You should leave a border of space a few centimetres around the image so when you add effects to the 

picture you don’t spoil the picture as certain effects do constrict the image. 

• You should be careful to check your words before you Snippet them, especially in Microsoft Word. The main 

problem is the spell-checker built in to Word. It underlines words in 

a curvy green or red line if it perceives a grammatical or 

spelling error. You should check the word and do what is 

neccessary to correct the word so that when you Snippet it that 

problem doesn’t transfer itself in to the challenge. Also, be 

careful where you put your cursor! You do not want it showing 

up on the challenge either. 

• Do not snippet the challenge description. Only snippet the challenge itself. Challenge descriptions must be 

typed in the Create a challenge form. 

• Finally, make sure your pictures are clear. The text should be readable, so make sure your font size is not 

too small. 

Using SmartArt  
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If you go to insert > SmartArt you can insert editable images which the editor has exploited to create 

challenges. Microsoft Word 2010 has an even bigger selection than Microsoft Word 2007. If you go to the 

‘Challenges to create’ PDF, you will find they are specific SmartArt templates used for specific challenges. 

Try not to overlap them.  

Feel free to try experimenting with SmartArt and its colours.  

Using shapes  

If you go to insert > Shapes you can insert some shapes to help you with the challenge design such as the 

‘lines’ arrows, which you can use on things like the D. Match challenges.  

 

Although we have not done this ourselves, you could use Microsoft 365 options of images in the icons tab, or 

else go to https://clipart-library.com or www.unsplash.com for free images to use for your challenges. Try doing 

some research and you may find other sites that offer free images. In the future, if you need an image for a 

challenge you are creating, you could potentially ask the online volunteer manager to get those involved in 

Picture It to create an image for you to improve your challenge aesthetically. 

Bonus questions and answers

Challenges can contain bonus questions which can get the 

recipient of the challenge some extra points. Feel free to add 

bonus questions to those challenges which are appropriate for 

them. Use your own judgement. You should recognise that a 

bonus question is usually a little unusual, but should relate to the 

previous question(s). For example, a bonus question on a 

crossword could be a diagonal backwards word, or a word 

created by the overlap of other words.  

A bonus question is perceived as a type of sub-part of the main 

challenge. As a result, in the below demonstration the main 

challenge question uses the PA point system to include the points one can earn from the bonus question, and 

the bonus question breaks this down by using the PP  point system. 

We have in the past separated bonus questions from the rest of the challenge by a light grey box i.e.  

https://clipart-library.com/
http://www.unsplash.com/
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As you can see, you should make it clear what the Bonus question is by using, if appropriate, the heading 

Bonus question in Font Arial, size 11 and Bold. You should also include the points the question is worth. In 

the answers section of the challenge on the Create a challenge document you should, especially if it’s a text 

based challenge, also have the heading Bonus answer. 

There’s more about this a few sections down under the heading Create a challenge, and under the sub-

heading Bonus answers. 

Some challenges and quizzes have sub-challenges, and this is where it gets tricky. 

This is because if we separated each challenge out individually it would mean we 

would run out of challenge letter codes very quickly since they can only go up 

to .Z. An example of a challenge with sub-challenges is challenge E.C 

Crosswords.  

Not only are they are range of different types of crosswords, like skeleton 

crosswords, or corner to corner crosswords, but also, they are different 

sources to which we use to create our crosswords, which we have listed on 

the Challenges to create PDF. If you decide to use a source such as the 

Statement of Doctrine to create the crossword, then the crossword 

becomes a Statement of Doctrine crossword.  
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The first line however in the challenge description should refer to the challenge name to which all the sub-

challenges belong. In this case, E.C is simply a Crossword challenge. That is the challenge name. However, 

what we do with sub-challenges names is we include them under the 1st line of the challenge description 

(which includes the challenge name), inserting it between the challenge instructions and the 1st line of the 

challenge description. The challenge instructions then should explain how to do the sub-challenge.  

As so: 

E.C   Crossword (5 points)  
Statement of Doctrine crossword 
Solve the clues and write them in the grid.  
 
In the case of sub-challenges, you should write the difficulty setting next to the sub-challenge name, not next 
to the challenge name.  
 

challenges
 
In the above case, because there is only one sub-challenge that has been used as part of this challenge (E.C), 
the font of the sub-challenge should not be bolded, neither should the points the challenge is worth be 
included on the same line as the sub-challenge name. However, if you are creating a challenge or quiz where 
they are multiple sub-challenges included therein, you should bold each sub-challenge heading and put the 
points you are using next to each sub-challenge heading, whilst also use the PA point system for the overall 
challenge heading which appears in the 1st line of the challenge description. An example is given below: 

 
 
 
Please recognize that when using a sub-challenge, that sub-challenge name, points, difficulty setting and sub-
challenge instructions are then to be seen as part of the overall challenge description.  
 
For the answers of sub challenges in the answers section, write the sub challenge name followed by ‘answer’ 
such as if the sub challenge was called David’s Mighty Men, the title of the sub challenge answer would be 
called David’s Mighty Men answer. We only added this innovation in July 2023 so some of the old challenges 
do not follow this rule. This would go in the third row of the Create a challenge table. 
 

Sub-

challenge 

heading 

Sub-

challenge 

heading 

Inc. Challenge name 

Sub-Challenge 

instructions 

Sub-Challenge 

name 

Inc. Challenge heading 
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For any given challenge, you can give it a sub challenge name which is just an additional name you feel would 
be fitting for the challenge if it doesn’t already have one. One example of this is if you were doing a maze 
challenge (challenge E.E), you could in the sub-challenge name call it ‘Get to the Kingdom maze’ if it’s just a 
standard maze, to help orientate the youths to the Kingdom. Only do this with challenges in which are not 
multiple sub-challenges.  
 

It’s important to recognise that they are two main different types of challenges:  

1. 

CE.Z challenges is the name for challenges that are aesthetic.  

They can be hand-drawn challenges, or challenges which include 

pictures, diagrams or other images and shapes, such as SmartArt. 

As a result, these challenges normally should simply be copied 

and pasted for the challenge answer part and filled out. For 

example, a crossword is a CE.Z challenge. The challenge 

question would be practically the same as the challenge answer, 

except of course the answer part would be filled out.  

It’s these challenges that we value most.  

2. Text based challenges

These are challenges that basically just have text and text boxes. An example of a text-based challenge is 

challenge T.A Building Character, challenge. When you are creating the challenge answer part you should 

just list the answers as follows: 

 

 

 

 

We cover the challenge answers part in detail in the next section.  
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Although we had come up with live challenges a while back, we didn’t add them to the Challenges to create 

PDF until November 2020. H. challenges are live chat challenges and possibly the reference to live groups 

which can be done by using a platform such as Zoom. The live challenges each have a symbol representing 

them as you can see on the Challenges to Create PDF. You could use the Create a Challenge document to 

create H challenges but they aren’t created for such. Rather, they will be for the Living Way to organise and 

plan out, ideally someone from Bethel and ideally a Graduate Obadiah, Senior Missionary or Deacon. To plan 

them, one could just script out how they’d like the live chat to go, have it checked, have it announced and then 

moderate it. If the Living Way Magazine ever 

starts again, then it could be announced in that. 

For example: “We have H.D Equip Challenge 

on Wednesday 15th September 2021 12:00 PM 

E.S.T. If you would like to take part in it, please 

contact the Living Way email address”. Similarly, 

with the online groups. It was thought that 

included in for example the BRP club, it could 

involve a brief quiz i.e. challenge N.M, to make 

the club more interactive, engaging and 

memorable.  

It is being planned that because H challenges 

are so useful, one should be able to obtain a chat 

spiritual point for their tribe for those doing online 

volunteering.  

The live groups will be also an excellent way to bring us all together, regardless of if they are volunteers or not 

and help foster a spirit of love, concern, unity and family for the people of Yahweh.  

‘Create a challenge’  
So now you’re probably just longing to start a challenge, right? On the www.messianicisraelite.com site, on the 

page Challenge Creation is a document called ‘Create a challenge’ not to be confused with the PDF 

‘Challenges to create’. You use the Create a challenge document to write your challenge description, and 

place your challenge question and challenge answer.  

Creating a challenge has two parts. The challenge question and the challenge answer. Because we try to 

make the challenges as aesthetically pleasing as we can, we often simply copy the CE.Z challenges for the 

challenge answers but then fill in the answer part. 

An example is shown below. 

This is the challenge question part of a Match – the – citation challenge: 

http://www.messianicisraelite.com/
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This is the challenge answer part of a Match – the – citation challenge: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

As you can see, there is a challenge question part and a challenge answer part. Both parts need to be 

submitted to the Living Way via the same Create a Challenge document. Alternatively, we could have just done 
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the answer part by listing the citations with the correct quotes next to them but, you have to think about what 

would look best in the Living Way magazine. Obviously, the above method would look better as it’s more 

aesthetically pleasing, is colourful and looks nice which will appeal to the youth, which is our primary target 

audience.   

Challenge instructions are the last segment of the challenge description when you are creating your challenge. 

Challenge instructions simply refer to the explanation of what the recipient of the challenge must do in 

order to complete the challenge.  You can go to the gallery on the 

www.messianicisraelite.com site on the Challenge Creation page 

and view some challenge instructions to get an idea of how to write 

them. 

We would like to create a set challenge instruction for every 

challenge which one would just need to copy and tweak to suit their 

challenge, but for now, you will have to create your own if there is 

not an example shown in that gallery. As the living way receives 

more challenges, we hope to be able to add at least one of each 

type to the Examples of challenges form.  

The most important thing about challenge instructions is they must 

be clear. The recipient of the challenge must understand what they 

need to do to do the challenge. If they don’t, then the entire 

challenge is a waste. You should also try to keep the challenge instruction quite short, preferably 1-2 

sentences long. Of course, this isn’t always possible, sometimes it may be longer. It should definitely not be 

any longer than 5 sentences. 

Ultimately, you will have to use your own judgement for now to create challenge instructions for the challenges 

you create.  

One thing to note about challenge instructions is we try when we can to put the recipient of the challenge in a 

situation. Instead of simply saying how to solve the puzzle, put the recipient in a situation, a quandary, whereby 

solving the challenge is how you get out of that quandary i.e. 

 

  

http://www.messianicisraelite.com/
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 For the challenge answer part on the Create a challenge form, the first thing you need to do is copy the 1st 

line of your challenge description from the challenge question which you should have created. You must then 

add the word ‘answer’ after the challenge name in the challenge description. 

For example, E.D Bible Maths Puzzle (2 points only) for the challenge question part would become E.D 

Bible Maths Puzzle answer (2 points only) for the challenge description of the challenge answer part.  

Finally, in the challenge description on the answer part, you may need to use the following 

symbols: .It’s a tick and cross symbol. To get them, go to Insert tab > 

Symbol > More symbols. Then select the Wingdings font and choose the 

character code #253 and #254. Change the font colour to red and font size 

11.  

If the point system you have used for the challenge is the PO points system, 

then you must include the tick and cross symbol in the first line of the 

challenge description in the answers part of the challenge. You insert them in 

the points part within the brackets i.e. 

E.D Bible Maths Puzzle answer (2 points only ) 

or 

S.B Sweet Proverb answer (1 point only ) 

 

If the point system you have used is PP or, PA, then you  do not put the tick and cross in the first line of the 

challenge description. Rather, for PA you break down your challenge answer with how much each segment is 

worth in points and using the tick and cross symbols. For PP, you’ll usually use the ‘1 point ’ symbols (or 

just ‘’) throughout the answer part of the challenge. This is to make it easier marking the challenges. All 

challenges should if possible have the tick and cross symbols, either in the challenge answer itself (usually 

which is an image, or SmartArt) or within the challenge answer instructions with the answers written out there 

also. Sometimes it will be easier to turn the symbols in to an image using the snipping tool and insert them as 

pictures throughout the answer part (the actual image) of the challenge. The tick and cross symbols must be 

no smaller than font size 11 if you are putting them in, not the challenge description, but the challenge itself. 

They can be bigger than that if you put them in the challenge itself. The tick and cross must always be red. 

See here for a demonstration. 

Some examples of PA point systems tick and crosses answers are shown below in the following challenge 

descriptions: 

 

 

https://messianicisraelite.com/wp-content/uploads/2021/09/C_edited-1-814x1024.jpg
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A very similar approach is taken with sub-challenges answers. In the section entitled Sub-challenges on page 

15 and page 16, you’ll find the information you need on when you need to include the points of a challenge 

next to just the overall challenge name, or, both the sub-challenge name and the challenge name. 

 If points are to be included next to the overall challenge name only, and the points system you have used is 

PO, then you must include the tick and cross symbols within the points brackets. If however, the point system 

you have used is PP, or PA, then you are not to include the tick and cross symbols within the point brackets 

next to the challenge name. Rather, you must put the tick and cross symbols throughout the challenge answer 

to break down how many points each part is worth. However, at times it will not be possible to do this, as you 

may read two sections down entitled Some exceptions.  

If points are to be included next to both the sub-challenge name and the challenge name, then you only need 

to concentrate on the sub-challenge name points system as to whether you should include the tick and cross 

symbols. Use the same rules as mentioned in the above paragraph to determine whether you put the tick and 

cross symbols here.  

The same rules apply for Bonus answers.  If you have included a bonus question, then in the answers part of 

the challenge you should have a section called Bonus answers and the same rules apply, as shown below: 
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Obviously, they are some challenges which do not fit this tick and cross system. Sometimes the graphic used 

simply doesn’t support the tick and cross. However, with most, if not all, SmartArt, you can insert the tick and 

cross symbols in the SmartArt itself.  

We will endeavor to make it clear exactly which challenges are exempted from the tick and cross in the future.  

1. When typing up the challenge answer part, and the answers are the names of people, you should 

capitalise those names.  

2. Normally, in the challenge answer part, the challenge description should not include any answer challenge 

instructions unless the challenge answer needs some sort of instructions to explain how to mark your 

challenge answer. Please differentiate between question challenge instructions and answer challenge 

instructions. Question challenge instructions explain what the recipient of the challenge must do to 

complete the challenge. Answer challenge instructions explain what the recipient of the challenge must do 

in order to score their challenge. A demonstration is shown below: 

Here is the challenge (question): 
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Here is the challenge answer: 

 

As you can see, there’s some answer challenge instructions as to how to mark yourself for the challenge. If 

those challenge instructions didn’t exist, then the recipient of the challenge might easily be mistaken to think 

one would need to get all of the answers to get the 5 points.  

Note: This is an old challenge. We no longer have 5 points only challenges any more. For PO points settings, 

the highest we have is 3 points only. See page 8.  

3. If you have used an answer from the scripture, you should include the citation of that scripture in the 

challenge answer so others can check where you got your information from for themselves. Normally, you 

do this under the challenge answer(s), in a light grey font colour, in brackets. i.e. 

 

4. If you have done a challenge which is worth 0 points, just copy the challenge description for the question 

part of the challenge and paste it in the answer part of the challenge description (so it’s exactly the same). 

Also, just copy the challenge you used for the challenge question part (even though it’s worth no points) to 

the challenge answer part so you have an exact duplicate of the challenge on the challenge question and 

challenge answer. The Living Way Team can then use any. Remember to write “(No points)” in the 

challenge description where the points setting would go. 

5. If you are writing out a challenge answer and you want to include something that isn’t part of the answer, 

but simply helps to elucidate the answer, you may include it but in a light grey coloured font so as not to 

confuse the recipient of the challenge to think that that is part of the answer. This may include citations in 

brackets.  
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Once you’ve decided on a challenge to create, you should: 

1. Take a notepad and pen and get away from the 

computer and plan your challenge. This often 

means you’ll have to choose challenges to do 

from the Challenges to Create PDF and do 

some Bible, AOY literature or AOY sermons 

study. 

2.  Once it’s planned, then you can hand-draw 

your challenge, or attempt to create it using a 

computer program such as Microsoft Word, or 

another program, like Photoshop.  

3. Once you have done this, and you have your challenge code etc and done your challenge question 

part and the challenge answers part, you can start filling out the ‘Create a challenge’ form.  

. 

The ‘Create a Challenge’ form is essentially a list of tables where you type up your challenge and copy your 

challenge question and challenge answer from whatever program you used to create the challenge. 

Below is how the first section looks like filled in: 

 

You have to select whether you are contributor or in an online group from the drop down list under Group 

no/tribe. If it is Yahweh’s will, online volunteering could become available where volunteers would do work in 

online groups, each online group given a tribe name. If you are just contributing work and not part of an online 

group, select ‘Contributor (N/A)’.  
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You are to put your name, the date, and if the AOY has put you in to an online group, your group number or 

tribe name, such as Reuben, Gad etc.  

The next section is where you start putting your challenges. 

It is important to point out that the Create a Challenge form is basically the standard guideline so that all can 

create challenges in an organised manner. It may be that a challenge you create would better serve a different 

layout. If this is the case, then you may change the table to suit that particular challenge.  

Filling Out the question section part  
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They are currently 8 rows to every challenge question part you create. The explanation of what goes in those 

rows is explained in the above snippet. Some rows won’t be needed; it depends what type of challenge you are 

creating.  

The first row

In the first row, goes the checkbox and challenge number. Please do not tick the checkbox. 

  

This is only for verifiers to check the challenge and approve it for use. Now, they are 7 challenge question 

tables. So, you won’t have more than 7 challenges. Normally, for the first challenge you create, you call this 

challenge #1, for the second challenge you create, you call this challenge #2 etc. This goes in the first row of 

the challenge question table.  

9. If creating a C challenge you can add a ninth 
row to include your status, whether affiliated 
with the AOY or member, and what country/state 
you live in and your flag. See further down for 
details.  
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Use the format of Font type, size and colour that we have used: 

❎Challenge #1 

However, if they are sub-parts to a challenge, such as with challenge N.E Statement of Doctrine quiz, then 

you are to put each sub-part of the challenge in to a different challenge question part table. Then, in each 

table, in the first row of that table, you are to put the challenge number to which the sub-parts belong to but add 

a + sign next to the challenge number i.e. 

. ❎Challenge #1+ 

That may sound confusing, so here’s an example to elucidate.  

The N.E Statement of Doctrine quiz has the following options called sub-challenges or sub-parts which 

comprise the quiz, which challenge creators can choose from to make up the quiz (see the Challenges to 

create PDF): 

1. Quote back challenge 

2. In Cite Challenge 

3. Which section? 
4. Subject & Page 

5. Missing Word 
6. Is this correct? 

7. Statement of Doctrine sort 

 
If a challenge creator chose ‘Quote back challenge’, ‘In Cite challenge’ and ‘Which section’ to make up the 
quiz, then they would undoubtedly have a problem when they come to the Create a challenge form, as a 
Challenge question table only allows one challenge, or sub-challenge, to be included in each table. 
 
Therefore, you would need to use three different Challenge question tables to include all three sub-challenges 
in to the quiz.  

 
Now, all these sub-challenges would belong to the same challenge, in this case, N.E . So if the first Statement 
of Doctrine quiz sub-challenge was in the first challenge question table, then in the first row of that table would 

state: Challenge #1. In the subsequent challenge table that refer to that same challenge, you would put: 

Challenge #1+ and then keep adding an extra + depending on how many sub-challenges you have: i.e. 

Challenge #1++ or Challenge #1+++ 

 
In these challenge tables with a ‘+’ you would skip row 2. You wouldn’t put anything in the row 2 rows. 

The SECOND row

In this row, you put the first line of the challenge description UNLESS as described above, the Challenge 

number has a +. Go to page 2, page 3, page 4 and page 5 of this instructions form and read sections: 

• Challenge descriptions and  

• Challenge descriptions and the finer points and 

• Where do you get a challenge code from? 
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There you will find the information you need to type out the 1st line of the challenge description. Please beware 

that if the challenge you are creating has sub-challenge(s) then the difficulty setting should be put in third row 

to describe the difficulty of that particular sub-challenge, not in the second row. 

The THIRD row

In this row, you put the sub-heading of the challenge and the difficulty setting. Most challenges don’t have sub-

sections, so you would just skip this row, but some do. We’ll use the example of N.E Statement of Doctrine 

quiz to show what one would do for a challenge that does have sub-parts/sub-challenges/sub-headings.  

Say, if you were creating a Statement of Doctrine quiz and you were to use the sub-challenge, Quote back 

challenge, as one of the sub-challenges to make up the quiz, that sub-challenge name would be included in 

this row, along with the point system you deem applicable, as seen below: 

Quote Back Challenge (6 points) 
 
Use Arial font, size 11 and Bold.  
 

The FOURTH row

Here, you put the challenge instructions. Go to page 19, to the heading Writing out the challenge 

instructions for assistance writing out the challenge instructions.  

The fIFTH row

Here you put the challenge! 

Now this may be a text based challenge or a CE.Z challenge. In any case, there needs to be a place where the 

participant of the challenge can write or draw their answers too. That might be just a space, or on a line like so: 

__________________________ 

The SIXTH row

In this row, you can put clues to help the participant work out the answers. Alternatively, these can be 

questions. Most of the time, you’ll probably just skip this row. However, this section is compulsory with 

crosswords. Below we have taken the clues from a E.C  Crossword Statement of Doctrine crossword i.e.  

 

You should use tables like the 

above for crossword clues. Use 

a similar format. We got the 

arrow symbol by going to the 

insert tab > Symbol > More 

symbols. Selecting font 

Wingdings and choosing 

characters #231 – 238.  

Besides crosswords, you can add clues to other challenges which might be quite difficult for some. We have 1 

example of this on the N.E Statement of Doctrine quiz, Quote Back Challenge as seen below:  
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To create that clue to help them solve the challenge, we simply typed up the sentence from the Statement of 

Doctrine in to a text box, but made it in to a missing word sentence. We used the Snipping Tool to turn it in to a 

picture and then rotated the picture vertically so it would be upside down, just in case participants wanted to try 

to do the challenge without the aid of a clue.  

You can also be creative when coming up with clues.  

The SEVENTH row

Again, most of the time challenges will not have a bonus question, but in the case that you decide to include 

one, then you should type it in this, the 7th row. The format is as follows: 

Bonus question (write points the question is worth here, in brackets) 

Write your bonus question here. 

You may want to read the Bonus questions and answers section on p. 10 of this document. You must 

understand that if you do include a bonus question, row 2’s point system will have to be adjusted to the PA 

point system to include the points available in the bonus question.  

THE EIGTH row

Finally, the last row. This is where you type the how-to-create challenge instructions. This is basically your 

chance to tell the Living Way how you created the challenge so that others, if they like your work, can copy 

your methods and produce the same quality work that you do. Please be as detailed as you can. This row will 

not appear when the challenge is published of course, but rather it should be transferred to the Challenges to 

Create PDF.  

So far, we’ve just edited the Create a Challenge question part table so it explains what to put in each row. 

Below, we have an example of what a Create a Challenge question table should look like when filled out: 
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You can note that those rows which you do not use should be left blank. They will be deleted by someone in 

the Living Way Team when they receive the challenges. Also, in row 8, the last row, they are the how-to-create 

challenge instructions, but we’ve cut it short simply because this challenge was created by someone who did 

work for the editor but at the time, we did not include how-to-create challenge instructions so any explanation 

as to how they created the challenge would be guesswork.  

 

ADDING A NINTH ROW (AN ADDITIONAL ROW)

You may add a ninth row to the challenge if your challenge is a C. challenge. This is optional. In it, you can put 

“[Drawn/Designed] by a [affiliated person / member] of the [insert country/state] assembly”. The font style 

should be Arial, font size 10. The text should be justified centre. In it, you can include a flag of your country in 

the box i.e. 

 

Keep it so it is the same format so that the first and second line contains the same text as the above. You can 

get find free flag images on the internet. The above flag image was taken from Microsoft Word 2016 emoji list. 

This will be encouraging for witnesses of the challenges to see all the different people contributing to 

challenges. Again, please only do this if you have created a C challenge.  
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It will be a relief to know that the challenge answer part of the Create a challenge form is easier to do. A 

challenge answer table has 7 rows instead of 8. Below are the instructions to what to put in each row

 

 

 

 

 

THE FIRST ROW

In the first row, goes the challenge answer number. This must correspond to the correct challenge question 

number. So, if the challenge answer you are creating is for the challenge number Challenge #2+ then the 

challenge answer number would be Challenge answer #2+. You’re just adding the word answer in there. Do 

your challenge answers in the exact same order as the challenge questions to make it easier for the Living 

Way and for yourself.  

Again, use the format of Font type, size and colour that we have used: 

Challenge answer #1 

THE SECOND ROW

To do the second row, you are to go to the corresponding challenge question part and copy everything from 

the second row of that table and paste it in to the second row in the challenge answer part table. However, you 

8. Like the challenge question part, you can add your 
country, state, membership status and flag to this 
part of the challenge if you have done a C challenge. 
Read further below for more details.  
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need to add the word ‘answer’ after the challenge name as explained in the sections How to fill out challenge 

answers part, The challenge description on page 20 of this document.  

Also, you may need to add the tick and cross symbol as explained in the section The tick and cross on page 

20. 

If you have used the PA point system you should break down the points with the tick and cross here, in this 

row, under the challenge description. However, you should only do this if you have an image to include in row 

5 to complement this challenge answer. One example of this kind of challenge answer can be seen below: 

 

Alternatively, if you have a picture to complement the challenge in row 5, you can also type out the challenge 

answer in row 2.  

 THE THIRD ROW

To do the third row, just copy the text from the corresponding challenge question table from the third row and 

paste it in here, the challenge answer table. You will need to add the word ‘answer’ after the sub-challenge 

name. You may also need to add the tick and cross symbol, so read the section called Sub-challenges 

answers on page 17 if you are unsure. Remember, you can just skip this row if the challenge answer doesn’t 

refer to a sub-challenge. 

THE fourth row

Under the heading Some challenge answers rules, point number 2, on pages 22-23 there is an explanation 

to when you need to write out challenge answer instructions. Most of the time, you won’t have to, so can leave 

this row blank. 

The fifth row

This would go in row 5 

of the challenge answer 

table. See page 2 of this 

instructions form to 

view the equivalent 

challenge question of 

this. 

All of this 

could go in 

row 2 of the 

challenge 

answer table. 
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Here goes the challenge answer! 

You may need to add the tick and cross symbols here if you have not done so in row 2. 

The sixth row

Here goes the bonus answer. You should read the sections Bonus questions and answers on pages 14-15 

and 11 and Bonus answers on pages 21-22 to help you go about this. Feel free to experiment.  

The seventh row

Finally, we come to the seventh row, which you are to write how you created the challenge answer, but only if 

they are aspects to it which you think would be useful for other people to know so they also can do the same 

thing. 

So far, we’ve just edited the Create a Challenge answer part table so it explains what to put in each row. 

Below, we have an example of what a Create a Challenge answer table should look like when filled out: 

 

 

You may add a eighth row to the challenge if your challenge is a C. challenge even if you have included this for 

the challenge question part. This is optional. In it, you can put “[Drawn/Designed] by a [affiliated person / 

member] of the [insert country/state] assembly”. The font style should be Arial, font size 10. The text should be 

justified centre. In it, you can include a flag of your country in the box i.e. 
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.  

Keep it so it is the same format so that the first and second line contains the same text as the above. You can 

get find free flag images on the internet. The above flag image was taken from Microsoft Word 2016 emoji list. 

This will be encouraging for witnesses of the challenges to see all the different people contributing to 

challenges. Again, please only do this if you have created a C. challenge.  

 

Challenges to be uploaded to the AOY 

WhatsApp group 
They are two main reflective challenges that will be uploaded to the AOY WhatsApp group 

• A.H Reflector (no points) NA     

• A.N Summary (no points) NA     

 
Other challenges are hoped to be uploaded as well, including other ‘no point’ challenges, but these in particular 
as they reflect on the sermons preached for the week. Most helpful if we had audio typist forms to easily 
overview the sermons.  

Spirituality room 
On the form we have the spirituality room feature which contains 4 aspects we call corners to encourage 

spirituality. One will be able to obtain points for your tribe for online volunteering through this feature. You can 

obtain 1 media, 1 study and possibly 1 chat point by taking part in challenge creation. Just ignore this if you are 

simply a contributor not a volunteer.  

 

The main goal of these categories is to help nurture the Holy Spirit and even though a Living Way email 

address hasn’t been created as of yet to enable contributions or volunteering, the editor hopes those who can, 

to use the seven categories on messianicisraelite.com to help foster their spirituality in the meantime however, 

for their own personal use.  
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Images larger than the Create a challenge 

form allows

We have things like C.C Story illustration or C.F Board game which would require larger size 

than the Create a challenge document allows. To submit these, write in the challenge 

description of those items in the Create a challenge document, but in row 5 where the challenge 

is to go, write, ‘SEE ATTACHMENT’.  

Then save your scanned file as the following: 

[First and surname of contributor]_[IN (for interested) / AF (for affiliated 

with AOY) / ME (for a member of the AOY)]_[Country they live in]_[County 

or State live in]_[Type of challenge such as C.F, or C.C etc ]_[Challenge 

name]_[Write challenge number such as Challenge 2 or if it’s the answer 

part Challenge answer 2]_[Today’s date in format dd.mm.yyyy] 

An example of this file name can be seen below: 

Joe Bloggs_AF_United States of America_Pennslyvania_C.F_Board Game_Challenge 3_20.12.2021.  

(Note: file names should be limited to 100 characters) 

Then attach it by email when you send over to the Living Way with your Create a challenge form. You may 

need to compress your files if they are too large to send in email by using an application like Winzip.  

Alternatively, once you’ve given the file the file name, you can share it with us through 

Google Drive or OneDrive or another file sharing site. Just copy the link to the email itself 

(paste the link in the message part of the email).  

A major rule about ‘Create a challenge’

They are seven different challenge question tables and seven different challenge answer tables to correspond 

with them. Please try to fill out all the tables with challenges so that the Living Way won’t have lots and lots of 

forms with (say) just one challenge on each. If you are creating a new challenge, then fine, but don’t submit it 

on its own. Submit it with challenges that already exist and are detailed on the Challenges to create PDF so 

you don’t end up sending the Living Way a practically empty form.  
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Saving the form before you send it as an 

Please use the following format to save your form when you send it to the Living Way.  

Challenges_[Write your name, first and last]_[IN for interested in AOY, write AF for 

affiliated with the AOY or ME if a member of the AOY]_[Write how many challenges 

you have on the form from 1-7]_[Write the date in format dd.mm.yyyy]_[If you have 

already sent in a form on this date, write the number form you have sent in i.e. 2, 3 etc, 

even if one form was sent in error] 

So a typical file name would look something like this: 

Challenges_Joe Bloggs_ME_5_11.12.2021 

Creating challenges not on our list 

As you already should know, you are to select a challenge from the Challenges to create PDF. However, the 

editor is not a challenge or puzzle expert. It’s more than likely that someone affiliated with the AOY will think of 

a challenge that isn’t mentioned on that PDF. That may be you.  

Note  After some careful consideration, the editor has changed the process of submitting new challenges 

ideas to help alleviate the living way. Please read the below instructions carefully.  

 

If you have a challenge idea not on our list, you may have to become an online volunteer first to submit your 

idea. Otherwise, you may be able to just email the Living Way email address with your challeng e idea. Use the 

Create-a-challenge form to send your idea. Use it to send 

the challenge name, along with the rest of the 

challenge description and a challenge 

example, both the question part and the 

answer part. If you are creating a new challenge, 

and your challenges fits a first letter challenge 

letter category like an E challenge, or a L 

challenge, write that Letter in your 

challenge description followed by a full stop 

i,e. E. but use the Highlighter Text Tool 

to highlight the challenge purple like 

so…E.. You can see page 4 for an overview of first 

letter challenge code categories. If your 

challenge doesn’t fit any of our first letter categories, write 

XX.X for your challenge code and where the How-to-create challenge 

instructions row would appear, write how you created the challenge and also your idea for 

a new category and what it would be called. Highlight your challenge letter code by going to the Home tab and 

above the Font dialogue box, selecting the Text Highlight Color Tool  
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and choosing the red color to highlight your challenge letter code, instead of yellow, or indeed purple, it being a 

completely new type of challenge. Currently, online volunteering is not available and neither is a Living Way 

email address. Just record your idea for now by writing it down.   

You may be a bit stuck when trying to create challenges. Right now (09/02/2022), the editor is creating 

templates for all the challenges so challenge creators will be able to just edit the templates so they can easily 

create challenges. These templates are hoped to be made available to online volunteers.  

Difference between ‘contributors’

‘volunteer’

At the present time (February, 2016), messianicisraelite.com has been set up as a foundation to which anyone 

affiliated with the AOY and is 16 or over may contribute work or good fruit to the Assemblies of Yahweh or 

Yahweh himself through the internet via the Living Way Youth Program. The individuals that send work to the 

Living Way by this method are called contributors. 

The difference between the volunteers and contributors would be that volunteers would be dedicated online 

workers, producing work consistently every 2 weeks, or, ‘every season’, whilst contributors would just send in 

work whenever they can or want to.  

We can provide in-depth instructions of how to create each and every 

challenge, and we are creating such, but for now we can just point you in the 

right direction and hope that you are able to produce something that works.  

However, it will be different for those zealous individuals who choose to 

become online volunteers for the Living Way. If it is Yahweh’s will, you’ll be 

able to discuss with each other how to create challenges properly, or how 

to do any aspect of this category. Further, you would be able to discuss 

with others of like-precious faith new ideas for challenges and design 

new and better formats.  
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As said previously, the editor knows very little about the subject of challenges. The knowledge obtained was 

from a retrieved old Living Way Youth Program Magazine (which at the time was called The Open Door) and 

subsequently then, some research in to different challenges by obtaining some challenge magazines. Yahweh 

blessed by allowing the editor to use a program as simple as Word to create most challenges. 

As a volunteer, you will be integral to the running of the Living Way Youth Magazine if it ever does start up 

again. Why? We cannot count on contributors. We do not know when they will send in work, or with how much 

work they will send in. If the AOY endeavour to start up the Living Way Youth Magazine which no doubt will 

cost money and time, then they’re going to need a faithful team of workers who submit high-quality challenges 

to them on a regular basis. Further, by volunteering, we can ensure that a spectrum of different challenges 

appear in the magazine, rather than just to have the same ones. 

Even if the LWYMagazine does not start again, the Living Way will be able to use the challenges produced in 

another capacity. Below is an example of a Challenge Creation assignment that appears on an assignment 

sheet: 

 

Further, online volunteers will be able to submit new challenge ideas and different volunteers will be able to 

use their talents in different ways. In the past, those who could draw drew images, then if necessary those 

images were sent to someone else to colour in those images on a computer or to ‘finish’ the image by adding 

effects. Everyone has a part to play and everyone can get involved, even if your skills are minimal.  

The vision the editor has is that the Assemblies of Yahweh could have an army of volunteers, online volunteers 

all over the world, who are beautifying the Assemblies of Yahweh both internally and externally and working in 

the Word of Yahweh, not only to strengthen themselves spiritually, but to strengthen all those who share in 

their works. This Body is the Truth, and we want to prepare this glorious Body as a beautiful Bride of the 

Messiah so Yahshua our Savior and soon coming King will be pleased at His Coming and even before that, 

that Yahweh could look down from heaven and see a people who love Him, love His Word, love Yahshua and 

love each other. The world may be becoming more evil and corrupt, but in the Assemblies of Yahweh we want 

to be becoming more spiritual, more loving. Let us prove to Yahweh our love every day and make the 

Assemblies of Yahweh the type of organization that Elder Jacob O. Meyer (OBM) envisioned years ago. 

 

 
“...and let us consider one another to provoke to love and good works.” 

         Hebrews 10:24 

         Sacred Scriptures Bethel Edition 
 
 

 

“May Yahweh challenge us daily to do His Will...” 

              The Seven Lamps of Yahweh 

              Elder Jacob O. Meyer 

 

www.messianicisraelite.com 
“Open the door” 

 

 

Hoped to be part of the: 

http://www.messianicisraelite.com/
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DISCLAIMER: This site has not yet been endorsed by the Assemblies of Yahweh and is 

not a part of the Living Ways Youth Program. The editor – a member of the Assemblies 

of Yahweh - has built this site to be part of the Living Way Youth Program, a program 

of the Assemblies of Yahweh (Bethel, PA). 

 
 


